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NOTICES

©2010 CardLogix Corporation®. All rights reserved. Printed in the U.S.A. This document is provided pursuant to an agreement containing restrictions 
on its use and is protected by federal copyright law. No part of this document may be reproduced in any form by any means or be used to make any 
derivative (such as translation, transformation, or adaptation) without permission in writing from CardLogix Corporation.

Disclaimer
Information in this document is subject to change without notice and does not represent a commitment on the part of CardLogix Corporation. 
CardLogix Corporation shall not be held liable for technical and editorial omissions or errors made herein; not for incidental, or consequential 
damages resulting from the furnishing, performance or use of this material. CardLogix Corporation reserves the right to revise this publication 
and to make changes from time to time in its content without obligation of CardLogix Corporation to notify any person or organization of such 
revision or change.

Trademarks
CardAppz®, M.O.S.T. Toolz®, and Smart Toolz®  are trademarks of CardLogix Corporation. Winplex® and Printplex® are registered marks of CardLogix 
Corporation. All terms used in this document that are known to be trademarks or service marks have been capitalized where appropriate. CardLogix 
Corporation cannot attest to the accuracy of this information. Use of a term should not be regarded as affecting the validity of any trademark or 
service mark.

General Notice
Some of the product names used herein have been used for identification purposes only and may be trademarks of their respective companies. 
Microsoft Windows 7, 2000, XP, and Vista are all registered trademarks of the Microsoft Corporation.

FCC
This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to part 15 of the FCC rules. These limits are 
designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate 
radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception,  which can be determined by turning the equipment off and on, 
the user is encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.•	
Increase the separation between the equipment and receiver.•	
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.•	
Consult the dealer or an experienced radio/TV technician for help.•	

 Statement of Electromagnetic Compliance 
This product has passed all electromagnetic interference and susceptibility testing required by the European Community and thus bears the “CE” 
mark.

This product has passed all electromagnetic interference and susceptibility testing required by the European Community and thus •	
bears the “CE” mark.
This Class B Digital Apparatus meets all requirements of the Canadian Interference Causing Equipment Regulations.•	
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CARDLOGIX CORPORATION SOFTWARE LICENSE AGREEMENT AND 
HARDWARE AGREEMENT FOR SMART TOOLZ DEVELOPMENT KIT

This Agreement is made by and between you (either an individual or an entity) and CardLogix Corp.1)	

TITLE
Subject to any rights deriving from any patent (either registered and/or pending and/or that can be registered).  CardLogix and/or any third party hold or shall 2)	
hold in the hardware (i.e. all the tangible elements of the PRODUCT) or any part thereof, CardLogix sells you the HARDWARE.

THE SOFTWARE CONTAINED IN THE PRODUCT (including any revisions, improvements and/or updates) and RELATED DOCUMENTATION (necessary and/or 3)	
related to the use of the PRODUCT, in hard copy and/or electronic form) IS NOT FOR SALE; title in and to the SOFTWARE & DOCUMENTATION shall remain 
solely with CardLogix.

LICENSE
CardLogix grants you a non-exclusive right to use the PRODUCT for the sole purposes of developing smart cards and smart card applications based exclusively 4)	
on CardLogix cards.  The SOFTWARE & DOCUMENTATION shall not be used for any other purposes.

You are permitted to make one (1) copies of the SOFTWARE solely for development and backup purposes.5)	

You may alter, merge, modify or adapt the Winplex® SOFTWARE but only in order to “and to the extent required” to merge it with your smart card 6)	
application.  You may not disassemble and/or decompile and/or reverse engineer the SOFTWARE or any part thereof.  You have a royalty - free right to 
reproduce and distribute binary executable files which include some or all of the Winplex SOFTWARE, only in binary executable form, provided that the 
binary executable files do not constitute an application that may compete  with and/or imitate and/or substitute the SOFTWARE. The media containing 
the binary executable files displays your copyright notice, and the title page or title page version of the documentation which accompanies the binary 
executable files contains the following CardLogix copyright notice:   
 
“Portions Copyright 1997 - 2010, CardLogix Corp.  All Rights Reserved.” 
 
Within forty five days of your first transfer or shipment of said application to a third party, you shall send CardLogix a copy of the CD label or title page 
containing the CardLogix copyright notice specified above.  CardLogix will acknowledge receipt of this copy.

In the event that you cannot satisfy the conditions of the above paragraph, contact CardLogix regarding an amendment to this Agreement.7)	

You may not rent, lease, loan, or sub-license the PRODUCT or any part thereof.  You may not transfer your rights under this Agreement to any party.8)	

Apart of the right of use explicitly granted herein, you shall have no other rights, express or implied, in the SOFTWARE.9)	

PROPRIETARY RIGHT
All intellectual property rights in the SOFTWARE & DOCUMENTATION and some of intellectual property rights in the HARDWARE are owned by CardLogix and 10)	
are protected by its copyright, patent, trademark, trade name and trade secret laws and international treaty provisions.  You agree that the SOFTWARE is the 
proprietary property of CardLogix and that it is distributed subject to restricted disclosure only and that the license does not convey to you an interest in or to 
the SOFTWARE, but only grants you a limited right of use in accordance with the terms of this Agreement.

The HARDWARE is provided “AS IS” and CardLogix shall have no liability to you for the infringement of any patents, copyrights, trade secrets or other proprietary 11)	
right by the HARDWARE or any portion thereof.
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LIMITED WARRANTY & LIMITATION OF LIABILITY:
CardLogix warrants that (a) the SOFTWARE will perform substantially in accordance with the accompanying user documentation for a period of 1 year from 12)	
the date of receipt and (b) that the HARDWARE, under normal use and service, is free from defects in materials and workmanship for a period of 1 year from 
the date of receipt.  Any implied materials and workmanship are warranted for a period of 1 year from the date of receipt.  Any implied warranties on the 
SOFTWARE and HARDWARE are limited to 365 days and/or one (1) year, respectively.  The foregoing warranty shall not apply to consumable portions of the 
HARDWARE which are expendable by nature.  Some states/jurisdictions do not allow limitations on duration of an implied warranty.

CardLogix’s entire liability and your exclusive remedy shall be at CardLogix’s option either (a) return of the price paid  or (b) repair or replacement of the 13)	
SOFTWARE or defective HARDWARE that does not meet CardLogix’s Limited Warranty and which is returned to CardLogix, with a copy of your receipt, within 
90 days of the date of receipt.  This Limited Warranty is void if failure of the SOFTWARE or defective HARDWARE has resulted from: (i) accident, abuse or 
misapplication and/or Modifications are made to the PRODUCT by anyone other than CardLogix; (ii) attachments, features or devices that are employed on 
the HARDWARE which are not supplied by CardLogix or not approved for use, in writing, by CardLogix; (iii) or other than the current version of the SOFTWARE 
available from CardLogix is used on the HARDWARE.  The warranty and remedies set forth herein are exclusive and in lieu of all others, oral or written, express 
or implied.  No CardLogix dealer, distributor, agent or employee is authorized to make any modification or addition to this warranty, save that nothing in it 
affects any rights you may have against us for death or personal injury caused by our negligence.

Except for and to the extent expressly provided herein, CardLogix makes no warranty or representation, either expressed or implied, with respect to the 14)	
PRODUCT, including its quality, performance, merchantability or fitness for a particular purpose.

Please note that the SOFTWARE is inherently complex and may not be completely free of errors.15)	   To the degree permitted by applicable law, in no event 
shall CardLogix be liable for direct, indirect, special, incidental, cover or consequential or any other damage whatsoever (including, without limitation, damages 
for loss of business information or other pecuniary loss) arising out of or related to this Agreement or the performance or breach of CardLogix’s liability and/
or the use of or inability to use the PRODUCT, even if CardLogix has been advised of the possibility of such damages.  In no case shall CardLogix liability under 
any provision of this Agreement exceed the amount actually paid by you for the PRODUCT.  To the extent that applicable law does not allow the exclusion or 
limitation of implied warranties or limitation of liability for incidental or consequential damages, the above limitation or exclusion may not apply to you.

GENERAL
This Agreement is governed only by the laws of the State of California and only the courts in California shall have jurisdiction in any conflict or dispute arising 16)	
out of this Agreement.

Any cause of action arising out of or related to this Agreement must be brought by you no later than one year after the cause of action has occurred.17)	

This License Agreement is effective upon your opening the accompanying Package and shall continue until terminated.  You may terminate this license 18)	
Agreement at any time.  Upon the breach by you of any term or condition of this License Agreement, and any subsequent failure to correct the breach within 
fourteen days of notification of the breach,  CardLogix may terminate this License Agreement.  Upon termination of this License Agreement by you or CardLogix, 
you agree to immediately return the SOFTWARE to CardLogix, to continue to maintain the SOFTWARE confidential, and to immediately destroy all copies of 
the SOFTWARE, whether in whole or in part, whether modified or not, whether in source object or binary executable.

COPYRIGHT
Copyright (c) 1997-2011 by CardLogix.  All Rights Reserved Worldwide.  No part of this publication may be copied or distributed, transmitted, 
transcribed, stored in a retrieval system, or translated into any human or computer language, in any form or by any means, electronic, mechanical, 
magnetic, manual, optical, chemical or otherwise; or disclosed to third parties without the express written permission of CardLogix.

DISCLAIMER
Although CardLogix endeavors to ensure the best possible product quality, CardLogix does not warrant that the Smart Toolz®, MIFARE®, and 
M.O.S.T. Toolz® Software will function properly in every hardware and software environment.  The Smart and M.O.S.T. Toolz® Software may not 
work in combination with some networks and some programs.  It may not work with modified versions of the operating system or with specific 
patches.  The Smart & M.O.S.T.  Toolz® Software may not function properly with certain modems and/or certain printers. Not all supported 
devices will work with all operating systems.

https://www.cardlogix.com/product-tag/mifare/
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Section I: Introduction��

Welcome to Smart Toolz® Smart Card Development Kit
With this kit, you will find everything you need to build a smart card system based 
on memory and contactless cards and to test out your ideas. The items included in 
your kit are production items and can be purchased in volume separately through 
CardLogix. The design environment is setup primarily for the storage of records 
and information. If you are building a stored value system that will require a wide 
distribution of cards, please call CardLogix sales at +1 949 380 1312 to discuss the 
specific issues relating to printing, terminals, security and card and key issuance.

How to Use This Manual
The CardLogix Smart Toolz® User Manual is divided into sections to help you use 
your Smart Toolz® as quickly and efficiently as possible. The sections include simple 
explanations and easy-to-follow steps that will help you understand the installations 
and functions of your Smart Toolz® kit. The guide assumes you are generally familiar 
with how to use a personal computer and are able to identify your USB, COM, and 
serial ports.

Smart Toolz® was designed for a variety of applications and for a variety of users 
with different skill levels. In order to help all users identify the sections of most 
interest to them we have employed the following iconography. When you see the 
 icon, it is an item for the general use of the system. When you see the  icon, the 
information is focused for programmers.

Section II: Getting Started��  – Provides information about your Smart 
Toolz® kit. Included in the kit are the installation instructions and your 
Warranty Registration Card.

Section III: Planning - New to Smart Cards:��  A general guide to smart card 
program development.

Section IV: CardAppz® Overview �� – An explanation of the use and 
implementation of a card system with CardAppz®. This is the recommended 
approach if you have no programming experience.

https://www.cardlogix.com/product/smart-card-application-development-kit-mifare/
https://www.cardlogix.com/downloads/support/7000001C_Smart_Toolz_Smart_Card_Development_Kit_User_Guide.pdf
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Section V: Card Configuration Utility (CCU) �� – Allows developers to 
complete their smart card projects through a program interface in a 
simplified design, test, and produce method.

Appendix A: ISO 7816 Error Codes��  – Describes error codes that can be 
returned from each type of smart card included in this kit.

Appendix B : Memory Address Range �� - A table listing the address ranges 
for the various card types.

Appendix C: Reader Command Matrix��  - Tables that cross-reference 
commands and particular reader types.

Appendix D: Glossary��  – Lists commonly used terms in the smart card 
industry.
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Section II: Getting Started��

Check the Contents of Your Smart Toolz® Kit
Carefully remove the contents of the Smart Toolz® kit. To protect your Toolz when in 
storage, save the box and all packaging materials.

Software License Agreement (second page of this manual);;

USB Contact-Contactless smart card reader/writer ;;

CD-ROM containing software, PDF documentation and examples;;

Smart Toolz ® User guide;;

Winplex;; ® User Guide

10 CardLogix sample cards, and technical briefs on each;;

CardLogix Warranty Registration Card (first page of this manual);;

Minimum System Requirements
To run Smart Toolz®, your computer must have a Windows 7, Vista, or XP SP3 
operating system running on a Pentium® PC with at least 128 megabytes of RAM 
and an optical disc drive.

Recommended: A Pentium® 2.4 GHz system or higher running Windows Vista© or 
Windows XP© SP3 with at least 256 megabytes of RAM and an optical disc drive.

Installing Smart Toolz®
Make sure to read and accept the terms of the Software License Agreement.1)	

Start Windows.2)	

Insert the program CD into your CD-ROM drive.3)	

Double click the Setup icon or, from the Windows program manager, select Run 4)	
from the File menu.

In the command line dialog box, type “d:\setup”, where d: is the letter of your 5)	
CD-ROM drive, and click OK.

Follow the on-screen instructions.6)	
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The setup program will copy the required files to your system and create the 
necessary program groups. To re-install the Winplex® API in another location, go to 
the Smart Toolz® installation directory, click on the individual folder and move the 
DLL’s to your working location.

Troubleshooting
If you are experiencing difficulty with any of the Smart Toolz® software or 
hardware please contact us at www.cardlogix.com/corporate/contact.asp or send 
an e-mail to sales@cardlogix.com describing the problem.

When contacting us regarding problems please make sure you have the following 
information available:

Smart Toolz® serial number (found on the inside lid of your box).1)	

Specify your operating system and system information.2)	

Specify the card P/N that is being used.3)	

Specify the DB# that is relevant.4)	

Describe the problem in detail.5)	

THE Smart Toolz® WARRANTY COVERS ONLY FUNCTIONAL DEFECTS, NOT 
IMPLEMENTATION DIFFICULTY! (See warranty for full details.)

Returns
Please contact CardLogix regarding any and all merchandise that is not performing 
to the published specifications. In the event of a defect in material or workmanship 
during the warranty period, CardLogix, at its discretion, will repair or replace the 
defective product after the defective product is returned to CardLogix by the 
owner. 

For return of product, you must be issued, by CardLogix, a Return Material 
Authorization (RMA) number. We cannot issue an RMA Number unless you have 
registered your system. This RMA Number is to be included in any returned 
merchandise. Please mark the RMA Number on the box and on the packing slip.

You are responsible for the shipping charges when returning items to CardLogix for 
quality review. If the items are found to be defective and within the warranty terms and/
or period, CardLogix will pay for all shipping charges (company policy is UPS 2nd day 
air) returning the devices to you.



SMART TOOLZ USER GUIDE ©20117000011A 5

Section III: Planning - New to Smart Cards

Section III: Planning – New to Smart Cards��

Summary

This section is divided into two parts:

Getting Started

This first section contains information about your Smart Toolz® Software 
Development Kit that will help you use it more efficiently. When appropriate, we’ve 
included links to CardLogix web pages related to the topic, for more information on 
our products and services.

System Planning

This section helps you plan, design, and implement your system with some general 
guidelines. These guidelines are meant for general reference only, and do not cover 
every possible design step and contingency. Additional information can be found 
at smartcardbasics.com and smartcardalliance.org.

Planning a card system can be a daunting task. CardLogix tries to make this 
task easier by providing an evolutionary path for your implementation with our 
products. At the beginning of this journey you will need to understand the issues 
around your business requirements in the context of cards and the ecosystem that 
they will interact in.

For your starting reference, you may need the following documents:

ISO 7816-1,2,3 specification at a minimum•	

ISO 14443 for contactless cards•	

CardLogix Specifications or Tech briefs for the card types that you will use•	

The CardLogix Graphics Design and Security Printing Guide•	 —This is an 
overview of graphics and printing to enhance card use and/or security. It 
is included in the Smart Toolz® documentation and is also available on the 
CardLogix site at http://www.cardlogix.com/support/documentation.asp

http://www.smartcardbasics.com/
https://www.securetechalliance.org/
https://www.cardlogix.com/


SMART TOOLZ USER GUIDE ©2011 SMART TOOLZ USER GUIDE ©20117000011A6

Section III: Planning - New to Smart Cards

CardLogix Specifications or Tech briefs for the readers or terminal types •	
that you will use 

The supplied Winplex® User guide•	

The supplied Smart Card Basics publication•	

When writing directly to the memory of a semiconductor, the specifications for 
each chip are very helpful. Due to confidentiality agreements, it is best to get 
these directly from the manufacturer.

To purchase the ISO specifications please visit www.iso.org for the latest 
documentation on ISO Standard 7816 and ISO 14443, which govern the design of 
contact and contactless smart cards.

To learn more about card and card reader choices, please visit www.cardlogix.com/
products/cards/smart/scfamilies/ and www.cardlogix.com/products/readers/.

To begin, we recommend that you start with the CardAppz® software demonstration 
application.

IMPORTANT NOTE - ASSIGNING CARD TYPES:  While using CardAppz® or the 
Card Configuration Utility (CCU), found  in the Card Toolz program group, at the 
step when you select a card reader, you must specify either ‘contact’ or ‘contactless’ 
to correspond with the type of card you are developing with. The supplied reader 
and software does not automatically select card type. Also,  if you are switching 
between applications you will have to reset the reader back for each program.

CardAppz® ��
CardAppz® helps build a card design, allowing you to demonstrate card capabilities 
within a completely configurable card database and system. CardAppz® enables 
you, the designer, to select templates, set security levels, and assign user types, 
from casual to power levels. This might be a design idiom for your project. This also 
allows you to check that the reader and cards are working as expected.

Card Configuration Utility (CCU) ��
This software gives designers the power to configure card parameters, load data 
into cards, and communicate with cards through the supplied reader. It is designed 
for the professional programmer. The CCU helps you visualize how data is displayed 
and configured in the card.
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Winplex®��  API
The Winplex® library includes provided sample code for reading and writing to a 
card and commands for managing many different reader types. With Winplex®, you 
can hook the card and reader into your software application quickly. The supplied 
sample executable and code enables code visualization for a variety of commands.

System Planning

Smart card system design requires advance planning to be successful and to 
avoid problems. It is highly recommended that you graphically diagram the flow 
of information for your new system. The first question to consider is ‘Will the card 
and system transact information, or value, or both?’ If it stores keys or value (i.e.; 
gift certificates or sports tickets), greater design detail is required than in data-
only systems. When you combine information types on a single card, other issues 
arise. The key to success is not to overrun the system with features that can confuse 
users and cause problems in management. We recommend that you phase-in each 
feature set as each one is working. To properly implement a functional smart card 
system you should be able to answer the following questions.

NOTE: These are only general guidelines, provided as a basis for your individual 
planning. Many other steps may be involved and are not mentioned here. For more 
extensive planning information regarding identity management and national IDs 
we recommend that you may want to review the GSA Smart Card Handbook. For 
financial card issuance we recommend the Global Platform Publications. If you have 
any questions, feel free to call your CardLogix sales representative and our team will get 
you pointed in the right direction.

https://www.cardlogix.com/product/winplex-smart-card-api-middleware-application-software/
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Card Choices - Considerations

The choice of card types is but one of many decisions regarding a card system. It is  
a choice that should not be based on card cost or performance alone. The total cost 
of ownership over the cards life weighed against performance is a better metric. 
The choice of contact vs. contactless cards should be based on:

Transaction Speed and user environments•	

Reader cost and use (contact readers are typically good for 250,000 •	
insertions)

(Contactless readers are typically 2x the cost)•	

Data movement (contactless cards cannot effectively carry large data •	
payloads)

On contactless cards, data storage is typically 2x the use for dynamic data •	
due to backup requirements

The next set of variables for consideration is file based cards vs. direct memory 
access. Direct memory access is usually the lowest cost per bit in the short term, but 
can have a cost or upgrade implications over the life of a program. By abstracting 
the card data into files that can be represented on many different card structures; 
a system will be less dependent on a single device or supplier and can be future 
proofed to a reasonable extent.

Some types of physical security features are more difficult to execute on a contactless 
card construction. Features such as colored interlayers and clear card bodies make 
construction costly and difficult. Also specific foils and holomag stripes can interfere 
with the antenna. Generally all other security features are available for both styles 
of cards.

The First Four

Do you require a completely original design? Or is there an existing 1)	
application that you can use? (For the latter, please visit CardLogix Smart 
Partners at www.cardlogix.com/smartpartners/apply.asp.)

Is there a clear business case? Does it include financial and consumer 2)	
behavior factors?
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What will the card be required to do? What are the card’s essential features? 3)	
With multiple functionalities, prioritize, starting with the most important 
one and phase in additional features incrementally.

Will the smart card handle data, value, or both? Adding a value function 4)	
increases system design security and complexity.

Basic Setup

Will the system be single- or multi-application?1)	

Are there industry standards to conform to ISO, EAL, or ETTSI for specific 2)	
encryption or chip requirements?

What information do you want to store in the cards?3)	

How much memory is required for the applications?4)	

If the system is multi-application, how will you separate different types of 5)	
data?

Will data be obtained from a database or loaded every time?6)	

Will this data concurrently reside on a database?7)	

How many smart cards will be needed?8)	

Have card or infrastructure vendors been identified? What are the lead 9)	
times?

What are the required reader types, handsets, terminals, and middleware?10)	

Is a Card Management System (CMS) necessary?11)	

Do I buy an off-the-shelf software and hardware for issuance? or do I have 12)	
CardLogix do this task?

Who will do the artwork?13)	

What is needed on the card? (e.g. signature panels, magnetic stripes, 14)	
embossing, etc.)

https://www.cardlogix.com/glossary/card-management-system-cms/
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Figure 2-1.  Multiple-application card usage system diagram.
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Physical Design/Graphics

How many types of artwork will be included in the issuance?1)	

What about security printing options? (e.g. guilloches, microprinting, 2)	
holograms, Card Validator® images, etc.)

Will I print variable data at issuance?3)	

Should the smart card be laser engraved to prevent low level tampering4)	

Will there be an over-laminate applied to the smart card?5)	

Do I need to consider level 2 (covert) and level 3 (forensic) type security 6)	
attributes on the card?

Will the card be distributed with a carrier (Tyvek sleeve, card wallet or 7)	
blister pack)?

Security

What are the security requirements?1)	

Does all of the data need to be secure? Or only some?2)	

Who will have access to this information?3)	

Who will be allowed to change this information?4)	

In what manner will you secure this data? (e.g. encryption, host passwords, 5)	
card passwords, PINs, etc.)

Should the keys/PINs be customer or system activated?6)	

How shall I diversify the system and card keys?7)	

How will you identify the card issuance and versions?8)	

Will the system utilize PKI and Digital Certificates? If so, how will they be 9)	
managed?

Value Applications

Is value in your cards re-loadable or one-time use?1)	

How will you distribute the cards?2)	

How will cards be activated and loaded with value?3)	

Will there be a refund policy?4)	

What is the minimum and maximum value to store on each card?5)	

https://www.cardlogix.com/news-room/cardlogix-introduces-card-validator-for-instant-smart-card-verification/
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Deployment Recommendations

Establish clear and achievable program objectives1)	

Analyze the application and IT environment2)	

Make sure the organization has a stake in the project’s success and that 3)	
management buys into the program

Set a budget4)	

Name a project manager5)	

Assemble a project team and create a team vision6)	

Graphically create a dataflow diagram7)	

Assess the card and reader options 8)	

Write a detailed specification for the cards and system9)	

Set a realistic schedule with inchstones and milestones10)	

Establish security parameters for people and the system11)	

Build your on-card and host file structures12)	

Phase in each system element and test as you deploy13)	

Re-assess your system for security leaks14)	

Deploy the first phase of cards and test the system15)	

Train the key employees responsible for each area16)	

Set up a system user manual17)	

Check the reporting structures18)	

Create contingency plans, should problems arise19)	

Deploy and announce your system20)	

Advertise and market your system21)	
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Section IV: CardAppz�� ® Overview

Software Overview
The CardAppz® Application Software allows you to test out and demo different 
data and card database structures without programming. This enables you to 
visualize a design and verify card feasibility quickly and inexpensively.  Once this is 
done, you can advance your design to production using CardAppz® and the Card 
Configuration Utility, plus the Winplex® API, the rest of your Smart Toolz® kit and 
any additional system elements – such as readers, to construct a solid backbone for 
card issuance.

The software is structured to take you through a series of logical steps that are 
easy to find, select and implement. When used in conjunction with the “Planning 
Your System” tips found in Smart Card Basics, you answer key questions that cover 
both the technical and business issues concerning smart card deployment. Each 
CardAppz® process step is set within a simple and intuitive framework, designed to 
look and feel like other programs you work with everyday.

Figure 4-1: CardAppz® Implementation Workflow
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Getting Around
Start CardAppz® by clicking on the  icon in the Smart Toolz® program group. You are 
first presented with the following dialog box:

Figure 4-2: CardAppz® Login Screen

The initial user name and password is found on the inside cover of your CD-ROM 
case. These settings should be changed as soon as possible by the software owner 
to prevent tampering. Refer to the section titled “Protecting your Information” on 
page 4-9 for more information.

After the initial login, you are presented with the initial SmartApp dialog box and  
Start-up Hints dialog box. You can close either of these screens by clicking the X in 
the upper right-hand corner.
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Figure 4-3: SmartApp & Startup Hints dialog boxes

The first option is pre-formatted databases. These are finished applications that you 
may use as is, or can be customized for your own individual requirements. If you 
need help with these sample applications, please contact CardLogix directly.

The second option is opening an existing application. This selection gets you to 
your designs as CardAppz® automatically creates a sub-directory for your work. The 
path can be viewed on the title bar of your file. You may also invoke this option at 
any time by clicking the Open button.

Figure 4-4: CardAppz® Open button

The third option is to create a new application. You may also invoke this option at 
any time by clicking the New button. Unlike some programs, CardAppz® requires 
you to first setup your file name before anything can be done. This is due to the 
integrated nature of the program.
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Figure 4-5: CardAppz® New button

Fill in the name of your planned card database in the dialog box. You can rename 
your file later if you wish. You will notice that your file name will appear on the title 
bar of the form.

Opening Your Work
Click the Open button or go to the File menu and pull down the Open 1)	
command.

In the Look In dialog box, click the drive that contains the document. 2)	

In the box beneath Look In that lists folders and files, double-click the name of 3)	
the folder that contains the document. Continue double-clicking sub folders 
until you open the sub folder that contains the document you are looking for.

In the list of files, double click the document name.4)	

Click Open or double click on the file name.5)	

Choosing Your Card Types
After the selection of a file name you must select a card type. The most important 
thing to remember when selecting a card type is user memory; unless you are 
building a stored value system (See “Planning Your System” for this information).

The information to be stored must be able to fit into the appropriate card size. This 
specific issue will be key to your overall system cost; so plan carefully. If you do not 
know the storage requirements of your system, use the formula we have provided 
below. It is the best method of calculating, in a rough order of magnitude, the bits 
needed for each card. For reference 8 bits equals 1 byte.

First go to Microsoft© Word (or any other word processing program that has a 1)	
word count function), and open a new document

Type or copy the maximum record information, line by line, representing each 2)	
field.

Go to the Edit menu and pull down the command for select all Ctrl+A, or 3)	
highlight all of the data.

Go to the Tools menu and pull down the command for word count.4)	

Take the total number of characters and multiply by  8.5)	
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This will give you an approximation, in bits, of what you will want to store. All cards 
over 1k bytes (8,000 bits) will be compressed automatically. Assume a minimum of 
10% gain in storage. If you encrypt a card you will increase the file size by at least 
10-15%. Encryption is only allowed on cards that are 1k bytes (8,000 bits) or larger.

CardAppz® gives you a card-by-card menu (see Figure 4-7) that pops up after you 
have started a new design. If you need to compare features,  any device can be 
selected by double clicking on the Select button for that part number.

Figure 4-6: Card type selection dialog box

Building Your Database
CardAppz® assumes you have a basic knowledge of database mechanics and you 
understand the differences between a field, file and record. After selecting your 
card type, you need to choose your database structure. These pre-formatted data 
structures are generic and should suit many applications.
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Figure 4-7: Database structure selection dialog box

Scroll through the selection thumbnails and take note of the file structure 
information on the bottom right of the dialog box. Each template has a card ID field 
already supplied for version control. You will also see a list of each card type as you 
click on each selection. If your chosen template does not match your selected card 
type you must click on the back button and choose another card type. 
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Labeling Your Fields
With CardAppz®, labeling your database is simple. Each file and field has an 
associated label that will describe its intended use for the user and your reports. To 
change the caption from label (1, 2, 3…) to your specific name, place your cursor 
over the label and double click on the item you want to change, as shown below.

Figure 4-8: Field labeling dialog boxes

In the label editing dialog box that appears, click on the item button and enter your 
new name in the dialog box. Click done if you are finished editing. To change the 
look and style of each of these labels you can invoke the label editor individually 
or as a group. To change all the fonts and label sizes for the file, click the Select 
All button on the label editing dialog box or go to the Format menu item and 
pull down to the command Select All Labels. Make your edits on the label 
editing dialog box and click done when finished.
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There are four primary character formats that you can apply with the Label Editor 
pop-up box:

Font type1)	

Font style 2)	

Font size3)	

Font color4)	

Note: The font’s appearance on screen and in print may differ, depending on your 
computer and printer. If you select a font that your system can’t display or isn’t installed, 
Windows will substitute a similar font.

Hint: To reposition the label more quickly in any direction, enable the button of the 
direction in which you wish to move your label, then hold down the Enter key or check 
the 10 x box.

Deleting A Field And Corresponding Label
To delete a field, place your cursor over the label associated with that field and 
double click on the label or caption and the Label Editing dialog box will appear. 
Select the delete button. You can delete a field at any time as long as it has not been 
locked.

Warning: In the process of establishing your database, you must be careful to delete 
only those fields that you are sure will not be needed after card issuance. Once cards are 
issued, deletion of a field will lose all data stored and reinstallation will not be possible. 
This will in turn render your issued cards unreadable, generating an error message when 
use is attempted.

Entering Your Data
To enter new data, click on the “New Record” button at the top of the page. The 
fields are now ready to accept data.
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Figure 4-9: Data entry dialog box

Getting data into the host system can be accomplished in four ways. 

The normal method is through standard manual data entry.•	
You can also cut and paste data from other CardAppz® files or from other •	
applications. For example, to edit large amounts of text you can open your 
favorite word processor, edit your text there, and then copy [Ctrl+C] and 
paste [Ctrl+V] it  into the CardAppz® database text field.
Data can also be read into the system from individual smart cards that were •	
created with the same CardAppz® software, provided that the passwords 
and keys match. 
The last method for entering data is to import data from other databases - •	
see Tools > Import.

Note:  For reasons of continuity, you cannot assign card numbers. Rather, these are 
assigned automatically, after you have entered your data, and have pressed the Update 
Record button.
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Exporting Your Data
To export a file, select Export from the Tools menu. This will automatically open up 
a sub-menu giving you the choice of saving to Microsoft Access Database Format 
or a  Delimited ASCII text file.

Properties
Can’t quite recall the properties of your cards or files?  Bring up the file in question, 
and click on File tab. From the drop down menu, select Properties. This will give 
file information and card information. File information will tell you the database 
type, when the file was created, when the file was modified, when the file was last 
accessed, and the host security attributes. Card information will tell you the type of 
card you selected, how many cards were issued, if there are passwords set, and if 
the cards are encrypted.

Saving Your Work
CardAppz® automatically saves your database when you create it. After editing the 
database template, choose Save from the File menu. This saves the overall layout 
and design of your database, not the records within the database itself.

As you enter data into your database, each data record within the database is saved 
when you click on the “Enter Record” button.

You can save a copy of the active database file with a different name or in a different 
location by going to the File menu and pulling down the Save As command.

Note: You cannot save a document in another file format. For example, you cannot save 
a CardAppz® document in a file format other than the .clx extension that the program 
was supplied with. To export data see Tools > Export.

To save changes to a read-only file, use the Save As command to save it with a 
new name.

Protecting Your Information
CardAppz® lets you, as the card issuer, set all of the parameters for card and data 
security. As an overview, there are two types of data system security, host-based 
and card-based. The safest systems employ both methods.
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Note: The protection of data is a subject of much debate. CardLogix provides a range of 
options for you to implement security but the ultimate choice and responsibility is yours 
as a card system designer and issuer. Most systems that are compromised are done 
so from the inside. Every reported breach of a smart card stored value system that we 
know of has been due to card emulation or theft through the mismanagement of keys/
passwords by disgruntled/unscrupulous employees.

Host-Based Security - File Access
The person designing with CardAppz® has the power to set the access levels to 
the program data and files from the host. The CardAppz® default mode uses no 
passwords except for the initial login. The first point of control to your CardAppz® 
system is the login password setup by a supervisor. All passwords are hashed and 
spread-out through the program so that simple points of attack are made more 
difficult. The initial user name and password should be changed immediately at the 
setup and editing of your first file.

The System has three file access levels. They are:

Supervisor - All rights and privileges to change databases, card ID#s, file •	
locking, encryption keys and labeling. This password must be set before 
the other two levels can be initialized.
User - This level is for the data-entry personnel to input and change data •	
on both cards and the host.
Viewer - This is a read-only mode.•	

These differing levels of program access are to demonstrate how a finished 
Smart Card Data Application may be structured. With proper programming 
and issuance all passwords should be replaced with cards as program access 
permissions are set.
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Figure 4-10: CardAppz® security levels diagram
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Setting Your Security Levels
Protecting  your CardAppz® database application is easy. Here is how you set your 
Supervisor, User, and Viewer passwords.

Note: Setting a Supervisor name and password replaces the default settings created 
by CardLogix at the point of manufacture. To ensure that the user name “Supervisor” 
and the password “Password” cannot be used again, they must be deleted by selecting 
Delete User instead of simply deleting the settings when prompted.Remember:  All 
passwords are case-sensitive.

Do not use a viewer password if you will be replicating a database. Replicated 
databases cannot be synchronized if database passwords are defined. 

Protecting your CardAppz® database application is easy. Here is how you set your 
Supervisor, User, and Viewer passwords.

Save and close the database file. If the database is shared on a network, ask A)	
all other users to close the database.

On the B)	 File menu, click Open.

At the file directory dialog box, choose your file and double click to open C)	
the database.

On the D)	 Security menu, pull down the command to User Manager, 
and then select the appropriate option: Create User, Delete User, 
or Edit User
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Select E)	 Permission Level: Supervisor, User, or Viewer

Enter User NameF)	

In the Password box, type your password. Remember passwords are case-G)	
sensitive.

In the Verify box, confirm your password by typing it again, and then click H)	
OK.

The password is now set. The next time you or any other user opens the database, a 
dialog box will be displayed that requests a password. Remember that a password 
is case- sensitive; you must type it exactly as defined.

Repeat this process for the user and viewer passwords as well.

Figure 4-11: CardAppz® user management dialog box

Warning: If you lose or forget your password, it can’t be recovered and you won’t be able 
to open your database. You are done for. Even our programmers can’t help you! There is 
no back door! Keep a list of your passwords and their databases in a safe place. 

Remember: All passwords are case-sensitive.

Do not use a file password if you will be replicating a database. Replicated databases 
cannot be synchronized if database passwords are defined.

If you need more extensive security than provided by a file password, you need 
to define user-level security. You can’t set a file password if user-level security has 
been defined for your database and you don’t have supervisory permission for the 
database. Also, a database password is defined in addition to user-level security. If 
user-level security has been defined, any restrictions based on user-level security 
permissions remain in effect.
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Encryption
The CardAppz® program supports three types of host-based encryption that can 
aid in card and card system security. Used independently, these methods will not 
necessarily prevent people from looking at the data in a card or file, but reading 
the files should prove to be a complete waste of time, due to the scrambled nature 
of encrypted data. All CardLogix cards with capacities above 32,767 bits or 4k 
bytes are automatically compressed using a loss-less algorithm incorporated in 
the CardAppz® system. This compression function alone applies a basic type of 
encryption.

The Data Encryption Standard (DES) is utilized for its proven security services. 
Developed in the early 1970s by IBM, DES is a Symmetric Key Algorithm (sometimes 
referred to as secret key). It is now considered the de-facto standard among many 
private industries and government. DES has been widely accepted as the standard 
for secure transmissions that conform to the requirements of the American Banking 
Association. When used with smart cards, DES data can be secured at a very low 
cost.

As an enhancement to DES we have incorporated Triple DES as an option for 
encrypting your data. This methodology requires two passwords per routine and 
can be used if you need enhanced security.

As a third option we let you apply the AES algorithm to your data. This proven 
algorithm has never been cracked and offers an encryption method that most 
hackers will not even guess at.

To encrypt a file you must first establish the file user levels.A)	

Next, go to Security on the menu bar and pull down to the encryption B)	
function you want to perform.

When the dialog box opens, fill in your passwords/Keys, write them down, C)	
and store them in a safe place.

Your passwords/keys can be any combination of numbers or text. The D)	
system will then exponentiate this input to a large digital number that 
becomes your electronic key for this encryption.

Warning: There are no back doors to your data; so consider these actions carefully 
before possibly locking yourself out of your own system due to misplaced passwords.
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Setting Card-Based Security
Various versions of the CardLogix memory card families support on-card passwords 
and digital keys. These functions may only prevent the alteration of the data without 
authorization. Please refer to the most current version of the CardLogix Smart Card 
Selection & Design Guide for the specific details. To establish higher security on 
certain cards, the memory must be fused at the point of manufacture. Please contact 
us regarding these issues directly. If your application will require higher security 
and needs to utilize dynamic password sessions and advanced authentication or 
encryption methods, please refer to the CardLogix M.O.S.T.® and Credentsys Cards 
to meet these requirements.

Note: If you are in need of a high security card system, contact CardLogix directly for 
information on our family of microprocessor cards.

To set up the passwords for on-card security cards, follow these simple steps.

Go to Security on the menu bar and pull down to the Set Card Password A)	
command.

When the dialog box opens, fill in your password and write it down in a B)	
safe place.

Your card password can be any combination of numbers or text up to 8 C)	
characters long.

After entering your password, make sure your card is inserted in the reader D)	
and you save the password to the card.

Key Management
Keys are passwords that are automatically presented by the reader. When setting up 
your passwords consider the issues of auto passing the key for convenience of the 
system user. Each group of applications may have one or more keys that separate 
the applications from each other. The following cards have a factory default key set 
for a customized system change. Contact CardLogix for more information.

CLXSA000KB1•	
CLXSB002KB5•	
CLXSB000KB6•	
CLXSU190KF6T=0ED•	
CLXSU004KK4T=0LC•	
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Sorting Your Data
By sorting your data in a specific structure you can often find information more 
quickly. This is true whether you’re looking at multiple records in a file, or viewing 
a list of values. In CardAppz® you can sort data in ascending order (0 to 9, A to Z) or 
descending order (9 to 0, Z to A) by going to the Navigator Bar and selecting sort, 
then select how you wish your fields to be sorted. The names you have given each 
field (in place of Label 1, 2, 3...) will appear in the “Sort Fields By...” window.

Figure 4-12: CardAppz® field sorting dialog box

When you are done with your proof of concept your are ready to take the next step. 
This step usually starts with the included Card Configuration Utility and/or M.O.S.T. 
Toolz® used in conjunction with Winplex® to complete your system.
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Design It.  Test It.  Produce It.

The Card Configuration Utility designed by CardLogix Corporation allows developers 
to complete their smart card projects in a simplified Design, Test, and Produce 
method.  Developers can design a card structure through an easy to use interface 
that provides access tools designed specifically for the features of the card that 
they are using.  This allows advanced features of a card to be implemented without 
spending endless hours in research and documentation.  At anytime, a project can 
be written directly to a physical smart card for testing prior to production.  That 
way developers can test their ideas and catch any mistakes.  Once satisfied with the 
design of their smart card structure, the utility can save a project as a project file to 
be sent to CardLogix for a production run.

I²C Memory Cards (A2 through A9)

Card Layout
I2C cards have a synchronous protocol that requires each reader to have support 
built-in, before use. Readers by SCM, MagTek and Omnikey do support these 
functions, but will vary in the support for the larger card densities such as 512k and 
1 megabit devices.

It is recommended that these details be investigated before your full system is 
deployed.

Design Note
If you are using the I2C devices for an embedded design, make sure that your reader 
is designed around the full electrical specification—including the lower voltage 
devices. As these devices mature and go through revisions with each semiconductor 
manufacturer, the electrical characteristics will vary.
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  I²C Memory Cards have a continuous memory system, starting with Byte 00

   The Card’s data is shown to the user in 256 byte pages

  You can edit bytes by selecting a byte and entering the hex values (using the 
0-9, A-F keys)

  The Tab and Arrow Keys can be used to select other bytes in the current page

  An ASCII representation of the byte values is displayed on the right side of the 
screen

Navigating the Card

To change to other pages of the card, click on the arrow indicators show above.  The 
blue boxes represent how many pages are available on your particular I²C card.  In 
the above example, for an A3 card there are 32 pages.  The lighter colored blue box 
indicates we are currently on the first pages of the card.  The boxes are clickable and 
will take you directly to that corresponding page.
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Card Function Menu

For I²C cards there is a special Card Functions menu.  The commands in this menu, 
all work directly with a connected reader and I²C card.  It will not affect your current 
project or memory.  This can be convenient for erasing a card on the fly, or for 
making a copy of a card. 

Special Memory Functions

These buttons provide special memory functions to the user. For example, you 
can quickly erase the working buffer with 00’s or FF’s. You can also import a text or 
binary file through the Write File to Memory button.
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MIFARE® Ultralight (CLXRN512UN1) Cards

Card Header Bytes

The first 10 bytes of the MIFARE® Ultralight (CLXRN512UN1) Card are read-only. They 
are set by NXP in advance at wafer finalization, based on a large order commitment 
to indicate manufacturer, card ID, serial numbers, and other information. Editing 
these values will have no effect on the card since they cannot be changed.
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Lock Bytes

Bytes 11 and 12 of the card are considered the lock bytes. The bits in these bytes 
lock pages (4 byte sections) of the card, beginning at the OTP area. Once a bit is set 
to 1 in a lock byte, the bit cannot be changed back to 0, so caution is advised when 
saving to a card.
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Lock Bytes Tool

We recommend using the utility shown, in order that specific pages or blocks of 
pages can be locked individually without the need to calculate byte values.
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One Time Programming

Bytes 13 through 16 of block 3 are bytes that can only change state one time. Any 
0 bit can be changed to a 1 bit but 1 bits can never be set back to 0 bits again. This 
feature can be used for a 32-tick one-time counter or as a “One Trip Pass” for events 
or ticketing. Optionally this block can be used for data storage where the values will 
not change later, like a serial number.  When used for this purpose, block 3 needs to 
be locked after programming.
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Data Area

This is the primary data area of the card. It is where your application data will be 
stored. The 48 bytes stored here can be modified by entering hex values (0-9, A-F) 
on the keyboard. You can navigate through the bytes using the tab or arrow keys.
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MIFARE® Ultralight C

Overview of the MIFARE® Ultralight C
The MIFARE® Ultralight C is a low cost, non-contact smart card with encrypted 
security.   The Ultralight C is useful for applications that do not require a great deal 
of memory, but do require security of TripleDES encryption.  This card contains 144 
bytes of user data, a TripleDES encryption key, a 7 byte unique serial number, and 
lock bytes for marking desired memory areas as read only. 

Typical applications where the MIFARE® Ultralight C would be useful include:  
Transportation, stored value/loyalty progams, gift cards, and secure area 
identification.

Card Structure
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The card structure of the MIFARE® Ultralight C consists of 48 blocks, as follows:

Blocks Definition
00 through 03 Card Header
04 through 39 User Data
40 through 43 Card Trailer
44 through 47 DES Keys

Card Header
The Card Header consists of a 7 byte Unique Serial ID, Block Check Character 
Bytes, and Lock Bytes that lock portions of the card as read only memory.  Bytes 
13 through 16 of block 3 are bytes that can only change state one time.  Any 0 
bit can be changed to a 1 bit but 1 bits can never be set back to 0 bits again.  This 
feature can be used for a 32-tick one-time counter or as a “One Trip Pass” for events 
or ticketing.  Optionally this block can be used for data storage where the values 
will not change later, like a serial number.  When used for this purpose, block 3 
needs to be locked after programming.

Block Byte 0 Byte 1 Byte 2 Byte 3
00 Manufacturer ID Unique Serial #1 Unique Serial #2 Block Check 

Character Byte 0

01 Unique Serial #3 Unique Serial #4 Unique Serial #5 Unique Serial #6

02 Block Check 
Character Byte 1

Internal Use Lock Byte 0 Lock Byte 1

03 One Time 
Programming 1

One Time 
Programming 2

One Time 
Programming 3

One Time 
Programming 4
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Unique Serial ID
Each card contains a unique 7 byte Serial ID, consisting of one byte for the 
Manufacturer ID, and 6 bytes for the remainder of the Serial Identification.

BCC0 / BCC1 Block Check Character Bytes
The BCC0 and BCC1 blocks contain checksum values for the header information.

Lock Bytes

Bytes 2 and 3 of Block 02 and Bytes 0 and 1 of Block 40 of the MIFARE® Ultralight C 
card are called Lock Bytes.  The values in those bytes correspond with areas that 
developers want to mark as read-only on the card.  We recommend using the utility as 
shown above to lock the various sections of the MIFARE® Ultralight C.  Once satisfied 
with your lock configurations you can lock each of the three sections permanently 
in their current states by clicking the corresponding Lock Check boxes.

One Time Programming
Block 03 Contains 4 OTP (One Time Programming) Bytes. These special handling 
bytes allow developers to add their own unique bytes that cannot be changed in 
the field*

*When a bit is set to 1, in the OTP area, it cannot be set back to 0. Because of the 
unique functionality of this area, it can also be used as a one time counter.
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User Data

Blocks 04 through 39 of the MIFARE® Ultralight C card are considered to be the User 
Data area.  This area consists of 36 Blocks of Data, or 144 Bytes.  This area is where a 
developer would put the primary application data.
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Card Trailer

Block Byte 0 Byte 1 Byte 2 Byte 3
40 Lock Bytes 2 Lock Bytes 3 Reserved Reserved

41 16 Bit Counter 1 16 Bit 
Counter 2

Reserved Reserved

42 AUTH 1 : Authenticate 
Block Start

Reserved Reserved Reserved

43 AUTH 2 : Authentication 
Type

Reserved Reserved Reserved

Lock Bytes 2 / 3
Bytes 0 and 1 of Block 40 consist of the Lock Bytes 2 and 3.  These bytes determine 
which sections of the card are locked in the second half of the card.  Be sure to look 
at the Lock Tool for easy manipulation of the lock byte values.

16 Bit Counter
Bytes 0 and 1 of Block 41 make up a 16 bit user counter.  Once a bit has been set to 
1 it cannot be changed back to 0.  This area can be used for applications that keep 
track of one-time use, such as a trip counter.

Authentication Bytes
The first byte of block 42 is called AUTH1. The value placed there determines the 
start of the authentication area.  The number entered there will be the number of 
the first block that needs to be authenticated with the DES keys.  Authentication 
is required for every block that follows that block number.  The transport setting 
of hex 30 (decimal 48) is one higher than the last block on the card (block 47), 
indicating that no blocks require authentication.  In the example shown, block 42 
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has a value of hex 25 (decimal 37) indicating that all blocks from 37 and up require 
DES authentication.

AUTH2, located at byte 43 determines the type of authentication required.  If the 
value at block 43 is 00 then authentication is for both Read and Write.  If the value at 
block 43 is 01 then the authentication required is only for Write operations and read 
operations are not restricted.  These two are the only authentication configurations 
possible.

DES Keys

The MIFARE® Ultralight C uses 3DES as its authentication encryption method.  
Blocks 44 through 47 make up the 16 byte secret key.  For security purposes, be 
sure that the second half of the bytes are not identical to the first 8 bytes or else the 
encryption method will be weakened to Single DES.  The 16 byte key used here will 
be for authentication with the card where required.

Finalizing Your Card
After you have set your card configuration values, write your configuration to a 
MIFARE® Ultralight C card using the File menu by selecting File>Save to Card.  
Using your application program, thoroughly test all card functions. 

Once you are satisfied that your card structure is working correctly with your 
application the next step is to send your card project file (CPF) to CardLogix to have 
‘check cards’ made.  Save your configuration settings to your project file using the 
file menu File>Save Project File or File>Save Project File As…

Send your project file to CardLogix.  Using your project file, check cards will be 
made and returned to you, along with a sign-off sheet.  After you sign off on the 
check card we can advance your design to full production.  You should also contact 
your CardLogix sales person for information on the personalization features of your 
card. 
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If your cards contain information that needs to be secure, such information may 
need to be transferred using an encryption method, PGP keys or other secure 
means of data transfer.  Please contact your CardLogix representative for further 
information.

MIFARE® 1K (CLXRN008KN3) Cards

Sector Trailer

Block 03 of each Sector on a MIFARE® 1K card contains a Sector Trailer. A Sector 
Trailer consists of an access key--called Key A, Access Bits that determine access 
privileges to blocks in the current sector, and Access Bits in the Sector Trailer itself. 
There is a second key--called Key B--that can be used to access specific areas of the 
card, or it can be configured as readable with Key A.

https://www.cardlogix.com/product-tag/mifare-classic/
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Sector Trailer Configuration

How you access the Sector Trailer For Read or Write Access is determined by the 
Sector Trailer Configuration. From this setting, you can choose the configuration 
that suits your current Sector. Click one of the Arrow Buttons to select one of the 8 
types of configuration.

The current configuration 001 shown indicates that using Key A, you can Write Key 
A, Write Key B, Read Key B, Read the Access Bits, or Write the Access Bits.
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In a different Sector Trailer Configuration such as 011, you can see that Key B will 
give us access to Write Key A, Write Key B, and Write Access Bits. 

The A/B setting here means that you can use either Key A or Key B to “Read Access 
Bits.” A setting of “OFF” means that no access is granted, in this case, to Read Key B.

Note: If you are going to use the B key as an access key for a Value or Data Block, you 
must configure the Read Key B to OFF. If the B key is readable it is not usable as a key.  The 
six bytes of the B key area can be used as extra data storage if it is not needed as a key.

Authentication Keys

Sectors that require authentication must be authenticated with a secret Key A or 
Key B depending on the configuration of the current sector’s Access Bits. Choose 
the radio button corresponding to the Key Set you require for your project. The 
default Transport Keys (FF FF FF FF FF FF) are the keys that are provided by default 
from CardLogix. Once keys are changed on a card, you will need to select either the 
Current Project File (Current CPF) or select custom keys from a Key File by selecting 
Key File and clicking the box here to choose the file.
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Custom Key Files

To change the authentication keys, go to the menu item Card Functions / 
Authentication Keys. From here you can change Key A and Key B settings for 
the sectors of a new custom key file. Remember, the settings here are not directly 
written to the card, but are instead saved to a key file that can be selected later.
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Value Blocks

Each data block in a sector can be either a standard data block that contains hex 
values of data, or a value block. A value block is a special block that contains values 
that can have the abliity to increment, decrement, or refill. From this configuration 
block, mark which corresponding block that you would like to set as a value block. 
You can also choose whether this value block has increment/decrement/refill(IDR) 
ability, or just decrement/refill (DR).

To set the value of a value block, use the tool shown above to type in the value, then 
click set for the appropriate block number. The value will be placed in the value 
blocks configuration. You can also click zero to zero out a corresponding block.
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Data Blocks

The block colors above show the three data blocks for this sector.  The colors 
represent the required key needed to read each data block.  In this example, data 
block 00 is readable with key B (yellow color).  Data block 01 is not readable (red 
color).  Data block 02 is readable with either key A or key B (purple color)  To view 
the access key requirements for writing, change the selector from Read to Write.

Data Blocks Configuration
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If you have a data block in your current sector, you can use this tool to set its access 
properties. You can choose from the following configurations:

Write with B Key•	
Write with A or B Key•	
Write Access OFF•	
Read with B Key•	
Read with A or B Key•	
Read Access Off•	

MIFARE® Plus 2K

Overview of the MIFARE® Plus 2K
The MIFARE® Plus 2K is a contactless smart card, with 2K of EEPROM of data.  The 
card features secure access and is backward compatible with the MIFARE® Classic.  
The MIFARE® Plus 2K is a secure card with up to 64 Keys protecting the 32 sectors 
of user data.  

Typical applications where the MIFARE® Plus 2K would be useful include:  
Transportation, stored value/loyalty programs, secure area access, and 
Identification.

Card Structure

The MIFARE® Plus 2K consists of 32 sectors of data.  Each sector consists of a sector 
trailer, and 3 blocks of user data.

https://www.cardlogix.com/product-tag/mifare-plus/
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Sector Trailer

A Sector Trailer is Block 03 of each Sector on a MIFARE® Plus 2K.  A Sector Trailer 
consists of Key A, Access Bits, and and optional Key B.  Key A is an access key, that 
allows reading or writing of the current Sector based on the user settings of the 
Access Bits.  Key B can also be used as an access key for certain rights determined by 
the Access Bits of the card.  Or it can also be used for additional user data.

How you access the Sector Trailer for read or write access is determined by the 
Sector Trailer.  The Sector Trailer Configuration utility allows users to easily change 
the sector trailer to their needs.  You can change the value of the sector trailer by 
clicking on the arrow buttons to select one of 8 configuration settings.

The current configuration setting of 001 shown indicates that you can use Key A 
to read Key B, Write to Key A or B.  In addition, with Key A you can allow reading or 
writing to the Access Bits.
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With a different Sector Trailer Configuration, such as 011, we can see that Key B will 
give use access to Write Key A, Write Key B, and Write Access Bits.  The A/B setting 
here indicates we can use either Key A or Key B to read the access bits.  A setting of 
OFF means that No Access is granted, in this case, to Read Key B.

Note: If you are going to use Key B as an access Key then you must set Read Key B 
to OFF.  If Key B is readable it is not usable as a key.  If it is readable, Key B can only 
be used as additional user data.

Authentication Keys

Authentication Keys

Sectors that require authentication must be authenticated with a secret Key 
A or Key B depending on the configuration of the current sector’s Access Bits. 
Choose the radio button corresponding to the Key Set you require for your 
project. The default Transport Keys (FF FF FF FF FF FF) are the keys that are 
provided by default from CardLogix. Once keys are changed on a card, you will 
need to select either the Current Project File (Current CPF) or select custom 
keys from a Key File by selecting Key File and clicking the box here to choose 
the file.
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Custom Key Files

In order to write to a card that has previously been modified with custom keys, 
you need to use a custom key file.  To change the authentication keys, go to the 
menu item Card Functions / Authentication Keys and view the 
following screen. From here you can change Key A and Key B settings for the 
sectors of a custom key file.

From here you can specify Key A and Key B settings for all sectors of a personalized 
MIFARE® Plus 2K card that will be saved or loaded later.  Remember, the settings 
here are not written to the card directly, but are instead saved to a key file that 
can be selected later.



SMART TOOLZ USER GUIDE ©2011 SMART TOOLZ USER GUIDE ©20117000011A 53

Section V: Card Configuration Utility

Value Blocks

Each data block in a sector can be either a standard data block that contains hex 
values of data or it can be a Value Block.  A Value Block is a special block that contains 
values that can have the ability to Increment, Decrement, or Refill.  From the Value 
Blocks Configuration, mark which corresponding block that you would like to set as 
a Value Block.  Choose whether you want this Value Block to Increment/Decrement/
Refill or just Decrement/Refill. 

To set the value of a Value Block enter the corresponding Block Number, the value 
you want to set it and click the Set button.

Writing or incrementing value blocks requires the use of the B key.  In order to use 
the B key it must be unreadable.  To make sure that the B key is unreadable, set Read 
Key B to OFF in the Sector Trailer Configuration.

*If Key B is readable it is NOT usable as a key.

Data Blocks

A card’s data blocks are where primary data is stored.  In the example shown above, 
the blue data boxes indicate that the data can be read with either the A or the B 
key of the matching sector.  If you want to see which key is required to Write to this 
sector’s data area, choose the Write radio selection.
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If you have a Data Block in your current sector you can use this tool to set it’s  access 
properties.  You can choose from the following configurations:

Write with B Key•	
Write with A or B Key•	
Write Access Off•	
Read with B Key•	
Read with A or B Key•	
Read Access Off•	

Finalizing Your Card
After you have set your card configuration values, write your configuration to a 
MIFARE® Plus 2K card using the File menu by selecting File>Save to Card.  
Using your application program, thoroughly test all card functions. 

Once you are satisfied that your card structure is working correctly with your 
application, the next step is to send your card project file (CPF) to CardLogix to 
have ‘check cards’ made.  Save your configuration settings to your project file using 
the file menu File>Save Project File or File>Save Project File 
As…

Send your project file to CardLogix.  Using your project file, check cards will be 
made and returned to you, along with a sign-off sheet.  After you sign off on the 
check card we can advance your design to full production.  You should also contact 
your CardLogix sales person for information on the personalization features of your 
card. 

If your cards contain information that needs to be secure, such information may 
need to be transferred using an encryption method, PGP keys or other secure 
means of data transfer.  Please contact your CardLogix representative for further 
information.
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MIFARE® 4K (CLXRN032KN4) Cards

Card Structure

A MIFARE® 4K (CLXRN032KN4) card consists of 40 sectors. The first 32 sectors (0 
through 31) contain 3 data blocks and 1 block for a sector trailer configuration.

The last 8 sectors (32 through 39) are structured with 3 groups of 5 data blocks, and 
1 block for a sector trailer configuration.

https://www.cardlogix.com/product/mifare-classic-ev1-4k-7uid/
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Sector Trailer

A sector trailer consists of two access keys, called Key A and Key B, and a 4 byte 
section labeled Access Bits that determines access privileges to blocks in the current 
sector.

Sector Trailer Configuration

How you access the Sector Trailer For Read or Write Access is determined by the 
sector trailer configuration. From this setting, you can choose the configuration 
that suits your current sector. Click one of the arrow buttons to select one of the 8 
types of configuration.

The current configuration 001 shown indicates that using Key A, you can Write Key 
A, Write Key B, Read Key B, Read the Access Bits, or Write the Access Bits.
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In a different Sector Trailer Configuration such as 011, we can see that Key B will give 
us access to Write Key A, Write Key B, and Write Access Bits. The A/B setting here 
means that you can use either Key A or Key B to “Read Access Bits.” A setting of “OFF” 
means that no access is granted, in this case, to read key B.

Authentication Keys

A card must be authenticated with a secret Key A or Key B depending on the 
configuration of the current sector’s access bits. Choose the radio button 
corresponding to the key set you require for your project. The default transport 
keys (FF FF FF FF FF FF) are the keys that are provided from the card manufacturer. 
Once keys are changed on a card, you will need to select either the current project 
file (current CPF) or select custom keys from a key file by selecting Key File and 
clicking the box here to choose the file.
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Custom Key Files

Custom key files are needed when writing to a card whose keys have been 
previously modified. To change the authentication keys, go to the menu item Card 
Functions/Authentication Keys.  From here you can change Key A and 
Key B settings for the sectors of a custom key file.
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Value Blocks

Each data block in a sector can be either a standard data block that contains hex 
values of data, or a value block. A Value Block is a special block that contains values 
that can have the ability to increment, decrement, or refill. From this configuration 
block, mark which corresponding block that you would like to set as a value block. 
You can also choose whether this Value Block has increment / decrement / refill 
(IDR) ability, or just decrement / refill (DR).

Data Blocks

The image above shows three data blocks for this sector.  The block colors represent 
the required key needed to read each data block. In this example, data block 04 is 
readable with key B (yellow color). Data block 05 is not readable (red color). Data 
block 06 is readable with either key A or key B (purple color). To view the access key 
requirements for writing, change the selector from Read to Write.
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Special Note: In the first 32 sectors of a MIFARE® 4K, the access bits affect its own sector 
trailer and 3 blocks of data. In the last 8 sectors of the card, the access bits affect 1 sector 
trailer and 3 groups of 5 blocks of data at a time.

Data Blocks Configuration

If you have a data block in your current sector, you can use this tool to set its access 
properties. You can choose from the following configurations:

Write with B Key•	
Write with A or B Key•	
Write Access OFF•	
Read with B Key•	
Read with A or B Key•	
Read Access Off•	

MIFARE® Plus 4K

Overview of the MIFARE® Plus 4K
The MIFARE® Plus 4K is a contactless smart card, with a 4K EEPROM.  The card features 
secure access and is backward compatible with the MIFARE® Classic.  The MIFARE® 
Plus 4K is a secure card with up to 72 Keys protecting the 40 sectors of user data.  

Typical applications where the MIFARE® Plus 4K would be useful include:  
Transportation, stored value/loyalty programs, secure area access, and 
Identification.

https://www.cardlogix.com/product/mifare-plus-x-4k/
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Card Structure

The MIFARE® Plus 4K consists of 40 sectors of data.  The first 32 sectors consist of a 
sector trailer, and 3 blocks of user data as shown. 

The final 8 sectors of a MIFARE® Plus 4K consist of a sector trailer and 15 blocks of 
user data.

Sector Trailer

A Sector Trailer is the final block of each Sector on a MIFARE® Plus 4K.  A Sector Trailer 
consists of Key A, Access Bits, and and optional Key B.  Key A is an access key, that 
allows reading or writing of the current Sector based on the user settings of the 
Access Bits.  Key B can also be used as an access key for certain rights determined by 
the Access Bits of the card.  Or it can also be used for additional user data.
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How you access the Sector Trailer for read or write access is determined by the 
Sector Trailer.  The Sector Trailer Configuration utility allows users to easily change 
the Sector Trailer to their needs.  You can change the value of the Sector Trailer by 
clicking on the arrow buttons to select one of 8 configuration settings.

The current configuration setting of 001 shown indicates that we can use Key A to 
read Key B, Write to Key A or B.  In addition, key A will allow reading or writing to 
the Access Bits.

With a different Sector Trailer Configuration, such as 011, we can see that Key B will 
give use access to Write Key A, Write Key B, and Write Access Bits.  The A/B setting 
here indicates we can use either Key A or Key B to read the access bits.  A setting of 
OFF means that No Access is granted, in this case, to Read Key B.

Note: If you are going to use Key B as an access Key then you must set Read Key B 
to OFF.  If Key B is readable it is not usable as a key.  If it is readable, Key B can only 
be used as additional user data.
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Authentication Keys

Authentication Keys

Sectors that require authentication must be authenticated with a secret Key 
A or Key B depending on the configuration of the current sector’s Access Bits. 
Choose the radio button corresponding to the Key Set you require for your 
project. The default Transport Keys (FF FF FF FF FF FF) are the keys that are 
provided by default from CardLogix. Once keys are changed on a card, you will 
need to select either the Current Project File (Current CPF) or select custom 
keys from a Key File by selecting Key File and clicking the box here to choose 
the file.

Custom Key Files

In order to write to a card that has previously been modified with custom keys, 
you need to use a custom key file.  To change the authentication keys, go to the 
menu item Card Functions / Authentication Keys and view the 
following screen.

From here you can specify Key A and Key B settings for all sectors of a custom 
key file of a personalized MIFARE® Plus 4K card that will be saved or loaded 
later.  Remember, the settings here are not written to the card directly, but are 
instead saved to a key file that can be selected later.
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Value Blocks

Each data block in a sector can be either a standard data block that contains hex 
values of data or it can be a Value Block.  A Value Block is a special block that contains 
values that can have the ability to Increment, Decrement, or Refill.  From the Value 
Blocks Configuration, mark which corresponding block that you would like to set as 
a Value Block.  Choose whether you want this Value Block to Increment/Decrement/
Refill or just Decrement/Refill. 

To set the value of a Value Block enter the corresponding Block Number, the value 
you want to set it and click the Set button.

Writing or incrementing value blocks requires the use of the B key.  In order to use 
the B key it must be unreadable.  To make sure that the B key is unreadable, set Read 
Key B to OFF in the Sector Trailer Configuration

*If Key B is readable it is NOT usable as a key.
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Data Blocks

A card’s data blocks are where primary data is stored.  In the example shown above, 
the blue data boxes indicate that the data can be read with either the A or the B 
key of the matching sector.  If you want to see which key is required to Write to this 
sector’s data area, choose the Write radio selection.

If you have a Data Block in your current sector you can use this tool to set it’s  access 
properties.  You can choose from the following configurations:

Write with B Key•	
Write with A or B Key•	
Write Access Off•	
Read with B Key•	
Read with A or B Key•	
Read Access Off •	
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Finalizing Your Card
After you have set your card configuration values, write your configuration to a 
MIFARE® Plus 4K card using the File menu by selecting File>Save to Card.  
Using your application program, thoroughly test all card functions. 

Once you are satisfied that your card structure is working correctly with your 
application the next step is to send your card project file (CPF) to CardLogix to 
have ‘check cards’ made.  Save your configuration settings to your project file using 
the file menu File>Save Project File or File>Save Project File 
As…

Send your project file to CardLogix.  Using your project file, check cards will be 
made and returned to you, along with a sign-off sheet.  After you sign off on the 
check card we can advance your design to full production.  You should also contact 
your CardLogix sales person for information on the personalization features of your 
card. 

If your cards contain information that needs to be secure, such information may 
need to be transferred using an encryption method, PGP keys or other secure 
means of data transfer.  Please contact your CardLogix representative for further 
information. 

MIFARE® 8K DESFire EV1

Overview of the 8K DESFire EV1
The MIFARE® DESFire EV1 cards from CardLogix are ideal for companies wanting to 
implement secure multi-application smart cards. The cards are ideal for many types 
of markets where transactional security is required, such as transportation, stored 
value/loyalty, and access control applications.

The card fully supports fast and highly secure data transmission in a flexible 
memory organization and is interoperable with existing reader infrastructures. The 
chip design gives the integrator freedom to abstract their files with very granular 
control over data security.

The MIFARE® DESFire EV1 is based on open global standards for both contactless 
interface and cryptographic methods. It is compliant to all 4 levels of ISO/IEC 
14443A. The chip is certified to EAL4+. Due to the file-based organization of the 
card, ISO 7816-4 commands can be executed like a standard CPU contact smart 
card.

https://www.cardlogix.com/product/mifare-desfire-ev1-8k/
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CardLogix DESFire Cards have an on-chip backup management system support, and  
optional three pass authentication. A DESFire EV1 card can store up to 28 different 
applications and 32 files per application. 

Applications
The 8 KB Non Volatile memory is organized using a flexible file system. This file 
system allows a maximum of 28 different applications on one MIFARE® DESFire EV1. 
Each application provides up to 32 files. Each application is represented by a 3 byte 
Application IDentifier (AID). You can think about the AID as a dedicated file in ISO 
7816 Style.  For each Application you have the following options:

Rename: This allows you to choose a different AID for the Application.  AID values 
are entered in hex bytes.  Each AID must be unique and can range from 000001 to 
FFFFFF.

Delete:  Permanently delete the application and any files it may contain.

Add:  Add one of five file types to this application.  The next available file ID  will 
automatically be chosen.  You can rename the file ID after it has been created.  Valid 
values for a file ID range from 00 to 1F.

Edit Access Keys:  Each Application can have up to 14 unique secret keys available.  
To personalize the values of the application keys, click on the Edit Access Keys 
button.  Key #00 of the application is considered the Application Master Key.  The 
AMK always exists and is critical to certain application features such as changing 
the app keys once they have been personalized.

File Types
The files within an application can be any of the following types:

Standard Data Files  

Plain unformatted user data that can be allocated to a user defined size.  This 
type of file is useful for applications that contain a wide variety of information, 
in various formats.  It is suggested for use where the data in this file is written 
by once at issuance and does not change since it does not have an anti-tear 
feature.  This type of file would also be most useful if you require the most 
storage space since there is very little overhead with this particular type of file.  
Please note for data integrity: This type of file is typically used for write once 
and read only data.
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 Backup Data Files    

Same as a standard data file, however, there is an anti-tear backup feature 
which makes it use twice as much storage.  This type of file would be useful 
for instances where a kiosk modifies the user card and there is a chance of 
the customer removing the card before the transaction has been completed. 
Contactless cards by their nature typically require this type of backup. This is 
due to a customers behavior of moving a card in and out of range of the reader 
antenna that supplies power to the card and maintains the transaction.

 Value Files with Backup   

Files for storage and manipulation of 32-bit signed integer values within 
a specified range.  This type of file is useful in cases where a single value is 
needed, one that can fit within a predetermined range.  This type of file could 
be used for a points or value system.  

Linear Record Files with Backup   

File for storage and manipulation of similar structural data, for example loyalty 
programs within an existing application on the MIFARE® DESFire EV1; once 
the file is filled completely with data records, further writing to the file is not 
possible unless it is cleared.

Cyclic Record Files with Backup   

File for multiple storage of similar structural data, for example, logging 
transactions within an existing application on the MIFARE® DESFire EV1; once 
the file is completely filled with records, the MIFARE® DESFire EV1 automatically 
overwrites the oldest record, allowing for continuous memory usage. This 
is usually used for recent financial transaction records or logging of other 
card functions to and from a terminal before a card is synced up to a master 
database.
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Application Keys

The MIFARE® 8K DESFire EV1 contains one primary Card Master Key that modifies 
various card features.  Each application within the MIFARE® DESFire EV1 also 
contains one Application Master Key and up to 13 additional secret keys for use by 
that application’s files.
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  In order to change an Application’s secret keys, left click the Application ID in the 
left pane window.  In the middle pane, click the Edit Keys button.  A window, like 
the one shown above, will pop up allowing you to edit that application’s key values.  
If you do not have values in mind for the secret keys you can click the Randomize 
Keys button to quickly generate random values for all the keys.
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Key Value Definition
0 Application Master Key

1-13 User Keys
14 Open / Free Access
15 Deny Access

Files on the EV1 card have an Access Keys property that specifies four key numbers 
required to Read, Write, Read&Write and for Changing the Access Keys property 
itself.  These keys can be specified by choosing them on the File Properties window.  
Key 14 can be used to allow Open Access.  Additionally, Key 15 is a special key that is 
used to Deny access.  For example, if you wanted a read only file, you could choose 
key #0 (The Application’s Master Key) for Read Access, and key 15 for Write and key 
15 for R&W access. 

Finalizing Your Card
After you have set your card configuration values, write your configuration to 
a MIFARE® DESFire EV1 card using the File menu by selecting File->Save to Card.  
Using your application program, thoroughly test all card functions. 

Once you are satisfied that your card structure is working correctly with your 
application the next step is to send your card project file (CPF) to CardLogix to have 
‘check cards’ made.  Save your configuration settings to your project file using the 
file menu File->Save Project File or File->Save Project File As…

Send your project file to CardLogix.  Using your project file, check cards will be 
made and returned to you, along with a sign-off sheet.  After you sign off on the 
check card we can advance your design to full production.  You should also contact 
your CardLogix sales person for information on the personalization features of your 
card. 

If your cards contain information that needs to be secure, such information may 
need to be transferred using an encryption method, PGP keys or other secure 
means of data transfer.  Please contact your CardLogix representative for further 
information. 
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Appendix A: ISO 7816 Error Codes��
Each operation returns a status code on completion. The possible codes are as 
follows:

ISO Error Codes
9000	 Operation completed successfully
6E00	 CLA not supported
6D00	 INS not supported
6300	 Warning, value read is different from value written (Write Binary)
6500	 Error, unable to erase (no “carry” bits available, Erase Binary and Restore)
6B00	 Error, invalid key value (Internal Authentication)
6700	 Error, wrong length (Internal Authentication)

Card Type 1 Error Codes
9000	 Operation completed successfully
6200	 Warning,  location(s) protected
6500	 Error, Data not written correctly, or no read issued after power up
6687	 Error, No More Retries, CLXSB008KB4 inaccessible (Verify)
6688	 Error, Invalid PSC presented (Verify)
6700	 Error, wrong length (Internal Authentication)
6D00	 INS not supported
6E00	 CLA not supported

Card Type 2 Error Codes
9000	 Operation completed successfully
6300	 Warning, data written does not match data read back (Write Binary)
6687	 Error, No More Retries, CLXSB008KB4 inaccessible (Verify)
6688	 Error, Invalid PSC presented (Verify)
6700	 Error, wrong length (Internal Authentication)
6B00	 Invalid Parameter (Erase Binary, odd address specified)
6D00	 INS not supported
6E00	 CLA not supported
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Card Type 3 Error Codes
9000	 Operation completed successfully
6500	 Error, Data not written correctly, may be protected memory
6687	 Error, No More Retries, CLXSB008KB4 inaccessible (Verify)
6688	 Error, Invalid PSC presented (Verify)
6700	 Error, wrong length (Internal Authentication)
6B00	 Invalid Parameter (Erase Binary, odd address specified)
6D00	 INS not supported
6E00	 CLA not supported

Card Type 4 Error Codes
9000	 Operation completed successfully
6200	 Warning, Card not responding, data may be written
6300	 Warning, Card not responding, data may be written
6500	 Error, Data not written correctly
6700	 Error, wrong length (Internal Authentication)
6D00	 INS not supported
6E00	 CLA not supported

Card Type 5 Error Codes
9000	 Operation completed successfully
6200	 Warning, Card not responding, data may be written
6300	 Warning, Card not responding, data may be written
6500	 Error, Data not written correctly
6700	 Error, wrong length (Internal Authentication)
6D00	 INS not supported
6E00	 CLA not supported

Card Type 6 Error Codes
9000	 Operation completed successfully
6200	 Warning, Card not responding, data may be written
6300	 Warning, Card not responding, data may be written
6500	 Error, Data not written correctly
6700	 Error, wrong length (Internal Authentication)
6D00	 INS not supported
6E00	 CLA not supported 
6B00	 Validation Error
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The following table lists the address ranges for the various card types.  This 
table should be used as a guide using the CLX_ReadCard and CLX_WriteCard 
commands. When using these commands, the offset and size parameters should 
be kept within a valid memory range. When the Page Mode is enabled (CLX_
SetPageMode command), the address of a CLX_WriteCard command must be on 
page boundaries.

Table C-1: Card Address Ranges

Card Type Part Number Memory Range Memory Size Page Size

1 CLXSB000KB1** N/A N/A N/A

2 CLXSB000KB2* N/A N/A N/A

3 CLXSB000KB6* N/A N/A N/A

4 CLXSA001KA1 0 - 127 128 8

5 CLXSA001KK1 0 - 126 127 N/A

6 CLXSA002KA2 0 - 255 256 8

7 CLXSA002KE1 0 - 255 256 8

10 CLXSA004KA6 0 - 511 512 16

11 CLXSA004KD2 0 - 511 512 N/A

12 CLXSA004KE2 0 - 511 512 16

13 CLXSA008KA7 0 - 991 992 16

14 CLXSA008KB3 0 - 127 128 N/A

16 CLXSA008KE3 0 - 1023 1024 16

17 CLXSA016KA8 0 - 2047 2048 16

20 CLXSA064KA3 0 - 8191 8192 32

21 CLXSA064KE4 0 - 8191 8192 32

22 CLXSA064KE6 0 - 8191 8192 32

23 CLXSA256KA5 0 - 32767 32768 64

24 CLXSA001MD1 0 - 1048575 1048576 64

25 CLXSA001KK1 0 - 126 127 8

26 CLXSA128KA4 0 - 127 128 32

*Card type is not currently supported. **Card type 2 (CLXSA000KB1), uses B1 API calls only.
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Appendix C:  Reader Command Matrix��
The following tables can be used to cross-reference which commands work with 
which type of reader. The numbers listed at the top of each table represent a specific 
reader type. 

Reader Type

General API Commands 1 9 10 13 14

CLX_OpenReader X X X X X

CLX_CloseReader X X X X X

CLX_CloseAll X X X X X

CLX_APIVersion X X X X X

Reader Type

General Reader Commands 1 9 10 13 14

CLX_GetError X X X X X

CLX_CardInserted X X X X X

CLX_ResetReader X X X X X

CLX_SetReaderLed X X

CLX_GetReaderVersion X X X X X

CLX_GetReaderStatus X X X

CLX_LatchReader X

CLX_UnLatchReader X

Reader Type

Magnetic Stripe Card Commands 1 9 10 13 14

CLX_StartMagCard X X X X

CLX_GetMagData X X  X X

CLX_StopMagCard X X X X

Reader Type

Encryption & Hashing Commands 1 9 10 13 14

CLX_3DESEncrypt X X X X X

CLX_3DESDecrypt X X X X X

CLX_AESDecrypt X X X X X
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Reader Type

Encryption & Hashing Commands 1 9 10 13 14

CLX_AESEncrypt X X X X X

CLX_DESEncrypt X X X X X

CLX_DESDecrypt X X X X X

CLX_Sha X X X X X

CLX_Sha1 X X X X X

CLX_ShaInternal X X X X X

Reader Type

Memory Card Commands 1 9 10 13 14

CLX_ChangePassword X X X X

CLX_EraseBinary X X X X

CLX_ReadCard X X X X

CLX_ReadCardtoFile X X X X

CLX_SetCardPageMode X X

CLX_SetCardType X X X X

CLX_VerifyPin X X X X

CLX_WriteCard X X X X

CLX_WriteCardFromFile X X X X

Reader Type

Microprocessor Card Commands 1 9 10 13 14

CLX_C0ExternalAuth X X X X X

CLX_C0GetResponse X X X X X

CLX_C0InternalAuth X X X X X

CLX_CardOn X X X X X

CLX_CardOff X X X X X

CLX_ExternalAuth7816 X X X X X

CLX_ExternalAuth7816Ex X X X X X

CLX_GenerateKey X X X X X

CLX_GetChallenge7816 X X X X X

CLX_GetResponse7816 X X X X X

CLX_InternalAuth7816 X X X X X

CLX_Invalidate7816 X X X X X

CLX_PurseDep X X X X X

CLX_PurseDep_Secure X X X X X
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Reader Type

Microprocessor Card Commands 1 9 10 13 14

CLX_PurseInit X X X X X

CLX_PurseVal X X X X X

CLX_PurseVal_Secure X X X X X

CLX_PurseWdl X X X X X

CLX_PurseWdl_Secure X X X X X

CLX_Read7816 X X X X X

CLX_ReadBinary7816 X X X X X

CLX_ReadSecure X X X X X

CLX_Rehab7816 X X X X X

CLX_Select X X X X X

CLX_Select7816 X X X X X

CLX_SetEncryption X X X X X

CLX_UpdateBinary7816 X X X X X

CLX_UpdateSecure X X X X X

CLX_Verify7816 X X X X X

CLX_Verify7816Ex X X X X X

CLX_Write7816 X X X X X

CLX_WriteBinary7816 X X X X X

CLX_WriteSecure X X X X X

Reader Type

B5 Card Commands 1 9 10 13 14

CLX_ReadB5Card X X X X

CLX_ReadB5ProtectionBits X X X X

CLX_VerifyB5Password X X X X

CLX_WriteB5Card X X X X

CLX_WriteB5ProtectionBits X X X X

Reader Type

K1 Card Commands 1 9 10 13 14

CLX_EraseK1AZ X X X

CLX_GetK1EC X X X

CLX_VerifyK1Password X X X
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Reader Type

K2 Card Commands 1 9 10 13 14

CLX_EraseK2AZ1 X X

CLX_EraseK2AZ2 X X

CLX_GetK2EC X X

CLX_VerifyK2Password X X
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AC: Alternating Current

ACK: Acknowledge. Used in a communications protocol to Acknowledge correct 
receipt of a message.

Answer to Reset: The response an ICC Card returns when the proper power 
sequence is applied. Defined in ISO 7816-3 for Microprocessor Cards. Definition for 
Synchronous Cards is not as well defined.

APDU: An Application Protocol Data Unit contains either a command message or 
a response message, sent from the interface device to the card; or conversely, from 
the card to the interface device.  

ASCII: A character set used by many computers.

Asynchronous Cards: Also known as Microprocessor Cards. ICC Cards which 
have a microprocessor and function according to ISO 7816-3 specifications for 
Microprocessor Cards. Asynchronous refers to the fact that they communicate 
using an asynchronous communications technique.

ATR: Answer to Reset. Elementary File indicating operating characteristics of card.

Authentication: The process of assuring that one, or both, parties to a transaction 
are who they say they are.

BCC: Block Check Character. Used in many communications protocols to detect 
errors in transmission.

BPS: Bits Per Second, abbreviated in either upper case or lower case. Refers to the 
number of bits which can be sent on a communications path in one second.

Card Seated: Refers to a card which is actually inserted fully into a card Connector 
such that the switch at the back of the reader slot changes state because of the 
contact with the card.

Card Connector: Any connector designed to receive an ICC.

Challenge: Some of the security schemes used with Smart Cards require a random 
number to be associated with key manipulations. The random number, which of 
course changes with every transaction/session, assures that no two occurrences 
of the same transaction will look the same, thus avoiding replay of secure 
transactions.

CLA: Class Byte. This is one of the bytes used in a APDU.

https://www.cardlogix.com/glossary/atr-answer-to-reset-smart-card/
https://www.cardlogix.com/glossary/apdu-application-protocol-data-unit-smart-card/
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Communications Protocol: A set of rules governing the structure, sequencing, and 
validation of messages between two or more points on a communications media.

CTS: A hardware signal from the host to the Axiohm Model 152 reader which allows 
the host to block transmission of data from the Model 152.

DB-9: This is the kind of connector used to connect to the host. If you were running 
a card reader using a PC as a host, this connector would mate to a “9 pin com port”.

DC:	Direct Current.

DF: Dedicated File. A file containing file control information and optionally, memory 
available for allocation. It may be the parent of EFs and/or DFs.

DLL: Dynamic Link Library.

EEPROM: Electrically Erasable Programmable Read Only Memory. Most Smart Cards 
store user data in EEPROM, which can be erased and re-programmed numerous 
times. See the card manufacturer’s specifications for information on the number of 
programming cycles available with a particular card.

EF: Elementary File. A set of data units or records which share the same file identifier, 
such as an ATR. An Elementary File cannot be the parent of another file.

EOT: End of Transmission. This byte is used in many communications protocols to 
signify the end of a transmission. In the ASCII character set it is defined to have the 
value 04H.

Erase: When talking about smart cards, erase usually means setting data bits to 
all ones. This is because EEPROM programming changes bits from the erased (all 
ones) state to zeroes a bit at a time, but cannot change single bits from zero to one. 
Currently available EEPROMs require at least one complete byte to change to ones 
(erasure) in order to change a single bit to one. Some EEPROMs erase in blocks of 2 
or more bytes.

ETX: End of Text. This byte is used in many communications protocols to signify 
the end of a transmission. In the ASCII character set it is defined to have the value 
of 03H.

F/D Ratio: F stands for Frequency, D stands for Divisor. In ISO 7816-3, these terms are 
used as a ratio (along with an oscillator frequency) to determine the actual speed of 
the smart card interface. ISO 7816-3 defines a default F of 372 with a default D of 1. 
When used with a standard oscillator frequency a speed of 9600 bps is the result.

Field: An area in the CardAppz® database file that tracks just one type of item, i.e. a 
city, state, ZIP code, and so on.  See also database and record.

File: A document saved to a computer disk.

Fuse: Many Memory Cards have a way of making an irreversible change to the card 
structure so that future modifications to certain portions of the card (i.e. card serial 
number) are impossible. Usually the technique is referred to as a fuse.

https://www.cardlogix.com/glossary/eeprom-electrically-erasable-programmable-read-only-memory/
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GeldKarte: A variant of the ISO 7816-3, Amendment 1, T=1 protocol.

GSM: Global System Mobile; A cell phone card standard.

HEX: Hexadecimal, base 16. Some numbers in this manual are followed by H (e.g. 
03H). This notation is to denote a HEX number.

Host: The device connected to the reader via the communications cable. The host 
controls all operations of the reader.

ICC:	Integrated Circuit Card. Any card which acts as a carrier for an Integrated Circuit. 
Most particularly, cards which conform to ISO 7816 standards.

INS: Instruction. This is one of the bytes used in a APDU.

ISO 7816: This international standard is used as a guideline by many smart card 
manufacturers. It defines standards (mechanical, electrical, operational) for a 
integrated circuit cards with contacts. Other standards apply to ICCs without 
contacts.

Key: Many smart card security schemes require the use of a “key” to prove either a 
reader has legitimate access to a smart card, or that a reader should accept a smart 
card as valid. Keys are passwords via the application.

Lc: One of the parameters which may be used in a APDU, it codes the length of data 
being transferred to the smart card.

Le: One of the parameters which may be used in a APDU, it codes the length of data 
expected to be returned by the smart card.

LED: Light Emitting Diode, the visible lights on the front of the reader.

LSAM: Local Secure Application Module. This is a Secure Application Module 
inserted in the LSAM Connector located inside the reader.

LSAM Connector: This Connector (if installed) is found inside the reader where it 
is not easily accessible to the general public. It receives the LSAM which allows the 
reader to be used for security applications. One disadvantage of having a SAM in 
an LSAM Connector is the possibility of the whole reader being stolen. Such an 
occurrence could (if the logical security scheme is inadequate), expose the owner 
to possible fraud. If the SAM is used to contain actual cash from transactions, the 
loss of the entire reader could mean loss of the revenue currently residing in the 
LSAM.

mAL: Milliampere.

Memory Cards: Also known as Synchronous Cards or Serial Cards. These cards do 
not have a microprocessor. They contain simple (relatively), circuitry which allows 
the card to read, write and update data. There are a variety of security mechanisms 
available on many cards.

https://www.cardlogix.com/product-category/smart-cards/memory-cards/
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Microprocessor Cards: Also known as Asynchronous Cards. ICC Cards which 
have a microprocessor and function according to ISO 7816-3 specifications for 
Microprocessor Cards.

MF: Master File. The mandatory, unique Dedicated File representing the root of the 
file structure.

ms:	milliseconds

Multi-drop:	Refers to techniques for multiple computers/devices to be attached 
to a single communications line and be able to communicate with each other 
coherently.

N/A: Not Applicable.

NAK: Negative Acknowledge. This term is used, usually when talking about a 
communications protocol, to designate how one party on a communications line 
tells another party that a particular message was not received correctly. Typically, 
when a sender receives a NAK, the sender retransmits the correct message.

OSB: Operation Status Byte. This byte is present in all responses from the reader 
when using either of the TLP-224 protocols available. It informs the host of the final 
status of the operation.

P1: One of the parameters used in a APDU. Specific usage depends on the APDU 
being used.

P2: One of the parameters used in a APDU. Specific usage depends on the APDU 
being used.

P3: One of the parameters used in a APDU. It is used to code either Lc or Le. If both 
Lc and Le are zero, P3 is zero.

PIN: Personal Identification Number. Many smart cards have security mechanisms 
with presentation of a PIN to authorize usage of the card.

Procedure Byte: This byte is part of the card level communications for 
microprocessor cards using the T=0 protocol. It used to regulate the flow of data 
from the card to the reader. The Axiohm Model 152 handles all procedure bytes, 
relieving the host of having to even know that procedure bytes exist.

Record: A collection of fields in a database that defines one entity. (Each card 
contains 1 record with the exception of the M.O.S.T.® Card family). See also Database 
and Field.

RFU: Reserved for Future Use. When sending a command to the reader, any field 
documented as RFU should be filled with zeroes.

RS232: An electrical specification of a communications system which is used 
between parties on a communications line. The Axiohm model 152 is RS232-
compatible.

SAM: Secure Application Module. Many Smart Card applications require security to 

https://www.cardlogix.com/microprocessor-smart-cards/
https://www.cardlogix.com/glossary/sam-card-secure-access-module-secure-application-module/
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protect against fraud. Many security schemes are implemented via SAMs which are 
smart cards which make security algorithms available and supply a secure place to 
store keys. It is quite difficult to discover the value of a key stored in a SAM.

SAM Box: This accessory, available for connection to many readers allows the 
reader access for up to seven additional SAMs. The SAM box may be stored under 
the counter or in some other secure location.

Secure Application Module: See SAM.

Serial Cards: See Memory Cards.

Smart Card: Any card with implanted, programmable, integrated circuitry.

SOH: Start of Header. This byte is used in many communications protocols to signify 
the start of a transmission. In the ASCII character set it is defined to have the value 
01H.

SW1 and SW2: These bytes are defined in ISO 7816 to be the last two bytes of any 
APDU response. They convey status information about the card operation.

Synchronous Cards: See Memory Cards.

T=0: One of the protocols defined in ISO 7816 for communicating with 
microprocessor cards. This protocol is byte-oriented, with error correction and 
recovery techniques applied on a byte-by-byte basis.

T=1: One of the protocols defined in ISO 7816 for communicating with 
microprocessor cards. This protocol is block oriented, with error correction and 
recovery techniques applied to whole messages.

TLP-224: One of the communication protocols supported by the Axiohm Model 
152 and 171 readers for communication between the reader and the host. This 
protocol is used by several manufacturers of smart card readers. If you use only the 
core set of commands in your application, your unit may be plug compatible with 
units from other manufacturers.

TLP-224 Turbo: A proprietary variant of the TLP-224 communications protocol 
which reduces the transmission time required to exchange messages between the 
host and reader.

Transport Code: A passwording technique used by many manufacturers of 
smart cards to assure that cards cannot be tampered with, or diverted to other 
destinations, for fraudulent purposes. There are many names used by manufacturers 
of this technique, but they are usually similar in nature and the level of protection 
provided.

https://www.cardlogix.com/glossary/smart-card-definition/
https://www.cardlogix.com/glossary/t0-protocol-smart-card/
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Appendix D: Glossary

Update: This function is used the second time you write to an Elementary File (EF). 
Most Smart Cards use EEPROM for data storage. If the new value to be stored at a 
location has any one bit where the old value had zero bits, the byte (or maybe a 
larger section of storage space) must be erased prior to writing the new value. In 
many cards the operation called “update” performs an erase before writing the new 
value to the card. Consult your card documentation to determine the exact nature 
of the “update” operation for your card.

User Connector: The card connector visible to the user. When the Axiohm Model 
152 goes through a power cycle, this Connector is selected.

USI2: One of the communications protocols supported by the Axiohm Model 152 & 
171 for communications between the reader and the host. This protocol is unique to 
American Magnetics. This protocol allows fuller usage of the features of the Model 
152, 154, 171 units.

Write: This is the function to use when you write to an Elementary File (EF) for the 
first time. (All subsequent writes are done via the UPDATE function). Most smart 
cards use EEPROM for data storage, if the new value to be stored at a location has 
any one bits where the old value had zero bits, the byte (or maybe a larger section 
of storage space) must be erased prior to writing the new value. If the byte is not 
erased, only bits which change from a one to a zero will be changed. In many cards 
the operation called “write” only changes one bits to zeroes. Consult your card 
documentation to determine the exact nature of the “write” operation for your 
card.
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